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EE261 Computer Project 1: Using Mentor
Graphics for Digital Simulation

  Introduction

In this project, you will begin to explore the digital simulation tools of theMentor
Graphics package available on the HP workstations in the Department of Electrical Engin
ing.

  Getting Started

If you have not yet worked the “Using Mentor Graphics: Design Manager and Bold
Browser” tutorial, stop and work that now before going any further.

Once you have worked the tutorial, log into one of the HP workstations in DL517, DL5
or CL137 using the instructions found in the sheet “Logging into the HPs,” available in CL1
InvokeDesign Manager by choosingDesign tools ⇒Mentor Graphics from the pop-
up menu.   To get to the pop-up menu in the X Windows environment (and inMentor Graph-
ics), press the right mouse button (RMB).   Selecting this menu item will startDesign Man-
ager and setup your environment. If you have trouble while inMentor Graphics, consult the
Bold Browser online help tool.   The browser can be started by double clicking on the
“bold_browser ” icon in the Tools window ofDesign Manager.

  Beginning the Simulation

In this part, you will examine the characteristics of a simple logic circuit. The circuit h
already been entered for you.

If you have not already done so, be sure to maximize theDesign Manager window now.
Look at the top of the Navigator window. (Remember: it’s the one with the arrows at the botto
You will see a path that looks like/rcc4/user6/student/drewn/mgc . This is the path to
yourmgc directory under your home directory. (Remember? You made thatmgc directory in the
first tutorial.) Write down this path now, you will need it in a minute.  Now, using the Naviga
let’s go to the EE261 directory. To do this, click on the “goto” button (the one with four arrow
When the dialog box pops up, click in the blank text box and enter:

/usr/local/classwork/ee261/mentor/project1/
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then press return. You will see a file come up,261Circuit1 . You will need to select and then
copy that file.  Select the file and chooseEdit ⇒Copy:  from the menu bar or the pop-up menu
(RMB).  At the destination prompt, enter the path toyourmgc directory (that you wrote down
earlier) and press return.

Now, using the goto button (four arrows) again, return to your Mentor directory.  You
should now see an icon called “261Circuit1 ” in the Navigator window. To start the simulator
you must “invoke it on a design”.  To do that, follow these steps:

1. Select the261Circuit1  icon.

2. From the pop-up menu, chooseOpen⇒QuickSimII .  Remember, it may take some time
before you see anything happen.

3. Minimize theDesign Manager window.  WhenQuickSimII comes up it will eventually
maximize itself to fill the screen. Once that happens, it will be done loading and you can g

At this point, Mentor only knows about the circuit and nothing about how you want to
simulate it. Therefore, you will need to set up the simulation before you actually simulate th
cuit. First, let’s take a look at the circuit. (See Figure 1) If you look at the palette (far right), y
will see eight brown buttons at the top.  These are the palette selector buttons and are ther
every palette.  With them you can switch between the available palettes, each containing a
ent set of tools.  Get to theSETUP palette now by clicking on its brown button.  To bring up a
view of the schematic, click on theOPEN SHEET icon in theSETUP palette.  When the sche-
matic appears, notice the input and output ports (or pads) in the schematic. (They are at the
of the circuit and look like a box with a point at one end. They have text on one side and a wir
the other). In a simulation you want to watch what electrical activity is happening on various
(wires).  To watch nets you need to tell the simulator to display the activity on them.

First, you need to tell it what nets to watch by selecting them.  To select the nets (wi
attached to the ports, click on each port. (The attached net should turn white if it is selected
unselect a net, click on it again.  To unselecteverything use theF2 key.  You could also use
Unselect ⇒All from the pop-up menu. This method of selecting and unselecting works fo
objects inMentor Graphics.  Make sure everything is unselected, then select all three inpu
(X, Y and Z) and the output (C) by clicking on each of their ports.  Now click theTRACE and
LIST  buttons on the palette.  When the Trace and List windows appear, notice that the sig
names are highlighted in all three windows.  This is calledcross-selection and is a key feature of
Mentor. If a signal is selected or unselected in one window, it will be selected or unselected
windows.

Next, you will need to set up the timing mode and define some input signals.  The tim
mode defines the timing parameters for each gate (you will learn more about this later). Uns
everything, then select just the four gates (three AND gates and one OR gate) by clicking on t
From theSETUP palette click theTIMING MODE button.  In the dialog box that appears, just
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make sure theTiming Mode  is set tounit . OK the form.  To finish the setup, create a clock
signal for Z  and input forces for the other two inputs.  Get to theSTIMULUS palette and, with
only the Z signal selected, click on theADD CLOCKbutton. Enter a period of 40 (the default time
period is ns) in thePeriod  box andOK the form.  This sets up an infinite clock signal on that
input that is active low (the default) with a 50% duty cycle (default again) and has a period 
40 ns.  Also by default, it replaces any other signals (clocks or otherwise) that were on that
before.  Select input X (only) and from theSTIMULUS palette clickADD FORCE.  Enter0 for
theValue , 0 for theTime  andOK the form.  This places a signal of value logical zero on the
selected input at time 0.0 ns.  Repeat this step for the input Y.

FIGURE 1. QuickSimII Screen for Project 1

The circuit is now all set up and you are ready to simulate it.  Be careful to readall the
steps below before you start the simulation.  To run the simulation, follow these steps:

1. You will run, stop, change the input, run and stop the simulation again. Read this entire se
before doing anything.  To start a simulation, typerun 40  and press return with the cursor in
any windowexceptthe palette. This will simulate the circuit for 40 ns and stop after that. Th
way you can run the simulator for any amount of time you like.The Trace and List window
display what events occurred during simulation.  The List only adds a new line when a s
you are watching changes (changes appear in green).  The Trace shows what happene
entire time the simulation has run.  To see all of the Trace output you may have to use th
Autumn 1999 3
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View ⇒All  command from the pop-up menu in the Trace window.  The input Z which is
driven by a clock changes between 0 and 1 automatically every 20ns. This is because the
has a 50% duty cycle and the period of the clock was set to 40ns.

2. The last step showed you how to run the simulation with inputs X and Y at logical zero a
driven by a clock (as you set them up).  Now you need to run the simulation with one inp
logical zero and the other at logical one. First, unselect everything. Next, change input Y
logical one.  To do this, select the input you want to change.  Then, from theSTIMULUS pal-
ette, click theFORCE TO STATE button.  Choose1(TRUE) .  This will cause the selected
input to have a value of logical one from the current simulation time on, or until you chan
that input again. It should be noted that this willnotaffect the signal value prior to the curren
simulation time (i.e.  you can’t change the past).

3. Now, run the simulation for another 40ns with this new set of inputs.  This can be done b
ing run 40  again.  Note that the time you give it is relative to the current simulation’s tim
(i.e. run 500 adds 500ns of simulation to the total simulation time). Notice the green tex
the List window. This indicates a change in value. You may have to scroll back through th
to see changes on signals. To see the changes in the Trace window you will need to zoom
To do this, use the pop-up menu commandVIEW⇒ZOOM OUT or VIEW⇒ALL while in the
Trace window.  You may also need to use the scroll bar to move around in the trace wind

4. Use the process described above to try all possible logical combinations of inputs X and

To interrupt simulation at any time typectrl-c . Only typectrl-c once. If you type it
more than once, you may be dumped out of the simulator completely and have to start ove
careful.   To resume the simulation typerun  followed by the duration and press return again.

Questions:

1. What does the output do for each case?

2. When you change one of the inputs, does the output change at the same simulation tim
(Note: you may have to zoom in around a change to examine this. You could also use th
window to see possible small delays in time.)

3. If there is a delay, is it the same for inputs X and Y?

4. What is the delay (in ns) from the input X to the output C?

  Drawing Waveforms

In this section, you’ll useMentor Graphics to draw/simulate the circuit in Figure 3-6
(page 109) of the course text. Begin by comparing the circuit on the screen to the circuit in F
3-6 in the text.

Now you’ll draw waveforms to match Figure 3-8 in the text. When you are done study
the traces from the previous section, you will need to reset the simulation time to 0.0 ns an
remove the input forces you applied to the input signals. To reset the time, clickRESETfrom the
palette area.  It is a blue button just above theList  button.  On the form that appears check the
Autumn 1999 4
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State  box,uncheck theSave ‘results’  box andOK the form.  This resets the simulation
time to 0.0 ns.  Now, use theunselect all  button to unselect all the signals.  Then select t
inputs X and Y.  From theSTIMULUS palette click theDELETE FORCES button.  In that form
selectSelected signals  andOK the form.  This removes the forces applied on the selec
signals.  Now the clock that was setup on the input Z is retained.Note: the timing mode you set
for the gates earlier is unaffected by any of these actions.

Now, select input X and go to theWF EDITOR palette (brown button).  Take a second t
look at the tools you can use to create and edit waveforms (inputs).  Next, click onEDIT

WAVEFORM. This will product an editable copy of the selected input(s) in the trace window. Y
only need to clickEDIT WAVEFORMonce to create the editable waveform. If you leave the sa
signal selected and click that button again, a duplicate (unwanted) copy will appear.  To rem
that copy (or any other unwanted trace), select the small hollow rectangle next to the trace
or above the label in the List window. This is called agadget. It will become highlighted when it
is selected. To delete it, press theDelete key or select delete from the edit menu. The editab
waveform will have a name likeforces@@/signalname .  Take some time and experiment
with the different ways of editing the waveform.  With the trace window active, click on a too
the palette then click on the waveform to edit it. When you are done with a tool, chooseCANCEL

in the lower left corner of the screen.  For example, if you use thePULSE tool, you need to hold
and drag over the area you wish to add the pulse. Also note, a pulse will not be added if you
two traces (vertically) while editing. If you tell a signal to go high at a certain time, and later
the same or a different tool tell it to go high at the same time, a red dot will appear.  This do
means that a duplicate force is being applied at that time.  To remove these, select theCLEANUP

tool and click on the dots.

When you feel comfortable drawing waveforms, make sure the signal(s) you were ed
are the only things selected, thenDELETE FORCES on them.  Scroll to time 0.0 ns if you need
to, and, using the methods above and theTOGGLE tool, draw waveforms on X and Y to match
Figure 3-7 of the text. You’ll probably have trouble getting theTOGGLEtool to change the input
at exactly time 0.0 ns. However, you can use theADD FORCEtool like you did in the last section
to set the desired value at time 0.  To get your inputs to line up with the clock signal (Z), yo
either add a new clock and draw your inputs to match it or you can draw your clock signal b
hand, just like you did for inputs X and Y.

Now you need to simulate the circuit with this set of inputs.  The simulator stops eith
when you tell it to (like in the last section) or when it doesn’t see any more inputs changing (i.
runs out of input).  In the first section you specified the duration of simulation, because the 
is an infinite signal that never stops changing. If you drew your clock by hand in this section
simulator will stop when it reaches the end of your drawn signals (the last time where one of
changes).
Autumn 1999 5



EE261 Computer Project 1: Using Mentor Graphics for Digital Simulation

t a

d if
you

ota
edit-

y of
,

xt
ut port
ur cir-

-input
the

e mid-
lace

look

o that
When you have run the simulation (and are happy with how it looks) you need to ge
print out of the trace.  (Note: in general, try to avoid printing out the List window.  It can bevery
long and doesn’t provide much information.  Use cut and paste to get the few lines you nee
you think the List data will better illustrate a point you are making.) First, set up which printer
want to use.  From the menu bar chooseMGC⇒Setup ⇒Printer... In the form, click on
the printer you want to use, click theSelect Printer  button, and thenOK the form.  Make
the window you want to print active (click in the Trace window in this case) and select
File ⇒Print ⇒Active Window... from the menu bar.  Make any modifications you
want,OKthe form and go collect your print out. WARNING: Be aware that there is a print qu
in the department. You can only print a total of 500 pages per quarter. Be careful to do your
ing online and only print what you need.  You can check your print quota anytime by typing
pquota  at a system prompt.

  Drawing Circuits

In this section, you’ll begin to learn about theMentor Graphics schematic capture abil-
ities.  You will use another tool to draw circuits calledDesign Architect.  Minimize the
QuickSimII window and double click on theDesign Manager icon to bring the window back
up.  Again select the261Circuit1  icon, then, from the pop-up menu, choose
Open⇒design_arch . Remember it will take some time before anything happens. Use an
the zoom functions (orView ⇒All ) to adjust the view so you can see all of the circuit clearly
once it has been completely drawn.

You will be modifying your circuit to look like the carry part (C) of Figure 3-6 in the te
book.  There are two ways you can change the circuit.  You could move the gates and outp
with the wires attached. You would then have to move the bends in the wires to clean up yo
cuit.  The other method is to delete the wires, move the gates and then re-draw the wires.

To make the change without removing the wires, move the mouse cursor onto the 3
OR gate and click the left mouse button to select it. The gate will become highlighted. From
pop-up menu or the palette, choose theMOVE command.  Notice as you move the ghost image
around, the wires connected to the gate stretch to move with it. Move the OR gate so that th
dle input is straight across from the output of the middle AND gate, then click the LMB to p
the gate there. Be careful of what is selected when using theMOVE(or any other) command as the
command will affecteverything that is selected.  To see how many items you have selected, 
in the upper left of the session window, below the menu bar.  You will see aSel:  followed by a
number. That number is how many items you have selected. Now move the output port C s
it is level with the output from the OR gate.  InDesign Architect, a port and its attached wire
are separate objects, unlike inQuickSimII.  You should select the output port and move it.
Autumn 1999 6
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FIGURE 2. Design Architect Screen for Project 1

At this point, your circuit is a mess, with the wires crossing everywhere.  To fix this, y
should move the points (bends) in the wires.  They are selected and moved in the same wa
wire or gate is. It may take some practice to select just the point and not the wire. (Hint: Wh
point is selected, it is highlighted by a white cross centered on the point.) You can also selec
move a point that is attached to the pin of a gate.  Move the points around so your circuit lo
similar to Figure 2. There is another way to do this automatically. When you click and hold d
the LMB while moving the mouse, the mouse pointer forms a rectangle and selects everyth
inside the rectangle when you release the button.  Use this to select the output wires of the
gates along with the OR gate. Stop the right edge of the rectangle at the middle of the OR g
that the output wire of the OR gate is not selected. Now, from theADD/ROUTEpalette, click the
ROUTE SELECTED tool icon.  This will automatically re-route the wires cleaning up all the
mess.

If you are unable to fix the circuit by moving the points you can use the other metho
deleting and redrawing the wires. You can select the things (wires in this case) you want to d
and press the Delete key.  You could do this before or after you move the gates.  After you 
the wires and you have placed your gates you need to replace the wires.  From theADD/ROUTE

palette, click theADD WIREtool icon or use the F3 key to start the wiring tool. To be electrical
correct, you should start and end your wires on the purple diamonds of gates. To start a wire
Autumn 1999 7
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once. To add a bend or anchor point anywhere, click once again. To end a wire, double clic
undo your last click, use thebackspace  key. When you are done, your circuit should look lik
Figure 2.Cancel  the wiring tool on the form at the lower left when you are done with it.

Now all you need to do is put your name on the circuit. Place the mouse over “Morri
Mano” and click while holding down this shift key. This action allows you to select comment te
which is not included in the selection filter by default. From theTEXT palette selectCHANGE

VALUE. A text prompt will appear in the lower left. Type your name and pressEnter . If you
need to, move your name around to fit better in the box.

Before you save the changes you have made, you need to make sure your circuit is e
cally correct. Do this by selectingCheck ⇒Sheet  from the menu bar. A report will appear. If
you have any errors or warnings you, will need to fix them, and then check the sheet again
Remember cross-selection fromQuickSimII? It works here also and is a good way to find the
source of your errors and warnings. If you have an error or warning it will tell you the locatio
something likeN$486 or I$271 . This is the handle tag Mentor uses to keep track of things. 
figure out what it refers to, highlight the handle in the report, then look at your schematic. T
corresponding part will be highlighted in your circuit as well. Fix any problems you have an
check the circuit again. When your circuit checks with no errors or warnings, save it by sele
File ⇒Save Sheet from the menu bar. When you have saved it, get a printout. You will ha
to setup the printer just like you did inQuickSimII (MGC⇒Setup ⇒Printer... ), then
chooseFile ⇒Print Sheet:  from the menu bar.

  More Drawing

Now try adding AND, OR and NOT gates to the circuit so that it is logically equivalent
Figure 3-6 from the text.  You will also need to add and label the output S.  To get the new 
chooseLibraries ⇒MGC Digital Libraries from the menu bar. This will display a list
of all the libraries available in the palette area.  To get back to the schematic palette or to m
around in the libraries, use the pop-up menu on the palette.  Back takes you up one level in
library and root will take you to the first list of libraries you saw.  Scroll down togen_lib  and
click on it. (If you don’t have scroll bars, turn them on from the pop-up palette menu.) You sho
now see a list of all the parts available in that library (listed in a short form). To place a part on
sheet, click on the part name in the palette.  A ghost image will follow the mouse pointer w
you move around the sheet area. Click where you want to place the part. The parts you will
are an output port, namedportout , a 3-input AND gate namedand3 , a 2-input AND gate
namedand2 , a 2-input OR gate namedor2  and an inverter (NOT gate) calledinv .  For the 3-
input OR gate you can copy the one that is already in the circuit.

When you place the ports on the sheet, they will have a name property of “NET”. You need
to change this name, using the same method you used to change “Morris Mano” to your na
Autumn 1999 8
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See the figure in the text to determine which port gets which name. To add the wires, use th
up menu in the palette to display the schematic palette, then click theADD WIRE tool. Use the
tool as described previously to add the necessary wires. If you are drawing a wire and it cros
pin or wire junction of another wire, and you do not explicitly connect it, a “not dot” will appe
This simply means that there is no electrical connection at that point. While you can leave the
place, it is suggested that you choose an alternate route for your wire to prevent the not dot.
you are done wiringCancel  the wire tool in the lower left corner. Check the sheet as before
make sure you have not made any errors. If you have, identify them and correct the problem
the sheet withFile ⇒Save Sheet . When you save the sheet, it will save over any previous
version of the circuit you had. If you want to keep the original version, save the circuit with 
ferent name by usingFile ⇒Save Sheet As...  Enter a component name for the new cir-
cuit andOK the form.Note: if you do this the schematic you have open is still the original. An
changes you make to this will be saved to the original unless you use theSave Sheet As...

command again. Get a print out of your new circuit for your report.

  Optional Extra Step

If you want to simulate your new design and don’t have aQuickSimII session running,
select the circuit fromDesign Manager and startQuickSimII on it. Set up the circuit as you
did previously and simulate it. If you still have aQuickSimII session running, and you saved th
changes to the original circuit, you do not need to exitQuickSimII and restart it. To load in the
changes you have made, close the Trace and List windows and get to theDESIGN CHANGE pal-
ette. From there selectRELOAD MODEL⇒ALL.This will causeQuickSimII to look at the cir-
cuit file and load any changes you have made to the circuit. You will have to set up the timi
mode for the gates again. It is also a good idea to delete all applied forces and create new
before simulating the circuit.

  Report

The report (one report per group) should be typed and follow the report format hande
in class. Be sure to include:

• Answers to the questions (1-4)

• A trace output from the simulation of the first circuit

• The schematic of the modified circuit (like Figure 2)

• The schematic of the final circuit (equivalent to Figure 3-6 of the textbook)

• Trace output from the simulation of the final circuit (optional)
Autumn 1999 9
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